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Abstract
This experiment simulated several flow fields around an RAE 2822 airfoil.  The primary goal of this experiment was to understand and compute the lift coefficients, drag coefficients, pressure coefficients, and pitching moment coefficients at different Mach numbers and angles of attack.  Flow Field Analysis is crucial in determining how well an airfoil will perform under various flow conditions and to find out if the airfoil is right for a specific aerospace application. Flow Field Analysis was performed for corresponding Mach numbers and angles of attack to examine how subsonic and transonic effects impact flow characteristics. The flow fields were generated using a 2D Reynolds Averaged Navier Stokes code. After the code was run, the output was imported into FieldView to visualize the flow fields. Plots of Mach number, Cp, and density were produced to examine the contours for each Mach number and angle of attack. The lift to drag ratio for the airfoil was highest for subsonic Mach numbers (M=0.2,0.5) at high angles of attack and lowest for the transonic Mach number (M=0.8) at low angles of attack. The flow fields for Mach 0.8 experienced local supersonic regions followed by shock waves that reverted the flow back to subsonic. The findings from the flow field analysis for pressure, density, and Mach number were consistent with compressible flow and shock wave theory.
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Introduction
When designing, or testing an airfoil it is important to comprehend the effects of upstream conditions to analyze the performance of the aircraft.  Wings contribute the most to lift and drag along an aircraft.  Therefore airfoil design is among the most crucial aspect of improving overall aircraft design.  The analysis of various flow field and aerodynamic characteristics can be observed from computer programs.

This report discusses an experiment that uses 2D Computational Fluid Dynamics and FieldView to compute a flow field around an RAE 2822 airfoil.  The flow field was used to determine the lift and drag coefficients at various Mach numbers and angles of attack.  The flow field also examines surface pressure changes with Mach number. 
[image: ]
Figure 1. RAE 2822 Airfoil (UIUC Applied Aerodynamics Group)

This experiment observed the RAE 2822 airfoil at Mach numbers 0.20, 0.50, and 0.80.  For each Mach number tested the airfoil was set to -2, 0, 2, 4, 6, 8, and 10 angle of attack.  FieldView was used to display flow field properties such as density, momentum, and energy.  The program also displays the contours of streamlines, Mach number, Cp, and density which were examined for shock waves, bubbles, supersonic flow, wakes, or any new feature. The effect of compressibility was observed for the airfoils performance between Mach 0.2 to 0.8. 

Theory 
Shock wave theory
A shock wave is a phenomenon associated with transonic and supersonic flow. While shock waves were known since the beginning of high transonic flight, it was not until the flight of Chuck Yeager and the Bell X-1 that supersonic shock waves were discovered. A shock wave is a thin, typically on the order of 100 nanometers, disturbance propagation when the flow speed exceeds the local speed of sound. In addition, the flow properties will also change dramatically across the shock wave. The total pressure, Mach number and flow velocity decrease, while static pressure, density, temperature, and entropy increase. Total enthalpy is the only characteristic that remains constant across a shock wave. Furthermore, due to the decreasing velocity, in a normal shock wave condition, the supersonic flow will not only decrease, but also become subsonic downstream of the shock..


Aerodynamic Coefficients 
Aerodynamic coefficients utilize the dynamic pressure of a flow to express the different forces on the wing. These coefficients can be derived mathematically or experimentally. Otto Lilienthal first used these coefficients during the 1800s. These unitless coefficients can be analyzed against each other to evaluate the performance of an aircraft. 
It is important to distinguish the 2D coefficients from the 3D coefficients. While 2D values can be easily determined using thin airfoil theory and potential flow, it is important to remember that these values do not take 3D effects into account, such as vorticity. These effects are incorporated using a correctional factor, the wing efficiency factor e, which is derived empirically. The wing efficiency factor varies from 0.9-1. Another useful correction factor is the Oswald efficiency factor which is a correction factor for the entire aircraft. This value ranges from 0 to 1 and therefore is not as useful as calculating it can be more difficult. 

Pressure Coefficient
The aerodynamic properties of a sectional airfoil can be modeled through the distribution of the pressure coefficient of the airfoil. It is customary to use Cp instead of the recorded pressure to describe the characteristics of an airfoil, as it is much easier to compare performance between airfoils using non-dimensional parameters. Equation 1 shows the elementary form of Cp.
                                                                                                                        (1)
For Equation 1, p is the local pressure, pinf is the freestream pressure, 𝜌 is the local air density, and Vinf is the speed of the flow. However, this description of Cp is not very useful for compressible flows. Equation 2, shown below, relates Cp and the Mach number to each other. This allows for compressibility effects to be shown more clearly.
                                                                                                          (2)
For Equation 2, γ is the ratio of specific heats for a given fluid, γ=1.4 for atmospheric air, Minf is the Mach number of the freestream, p is the local pressure, and pinf is the pressure of the freestream. 

Lift Coefficient
For simple calculations the lift coefficient, CL, is calculated assuming lift is equal to weight and solving the lift equation. This method is useful for calculating CL when all of the aircraft data is given. However, it can be solved mathematically using thin airfoil theory. This will give the 2D Cl which does not take into account 3D effects. Equation 3 represents the two-dimensional lift coefficient is written in terms of lift, dynamic pressure, chord length.
                                                                                                                               (3)

As mentioned earlier, efficiency factors are used to correct for this error. CL is mostly solved using commercially available codes such as Xfoil, which generate results similar to those found experimentally under ideal conditions. The equation for CL is represented by equation 4, where CL0 is the lift coefficient that the airfoil generates at zero angle of attack and CL𝛂 is the lift coefficient as a function of the angle of attack. 
                                                                                                             (4)
[image: ]Judging from the graph, the lift coefficient increases as a function of angle of attack until it reaches the critical angle of attack, at which point the aircraft will stall and the lift coefficient will decrease significantly. If the angle of attack is too high, the flow will detach from the wing and stall will occur. An important note about this graph is that its slope is 2𝝅. This means that the graph plots the 2D coefficient. Again, this is corrected for with e and e0.Figure 2. Lift Coefficient vs Angle of Attack


Drag Coefficient
The drag coefficient Cd is calculated by taking into account the skin friction drag and the pressure drag on the airfoil. The two-dimensional lift coefficient is represented by Equation 5, written in terms of drag, dynamic pressure, and chord length.
                                                                                                                                (5)
                                                                                                                                  (6)
The most common types of drag include skin friction and induced drag. Skin friction drag, Cf , is calculated using the Reynolds number, shown in Equation 6. Reynolds number will change with Mach number, since it is proportional to velocity. This means that compressibility will have an effect on Cf, since an increase in Mach number (and velocity) will increase skin friction drag. It is important to distinguish whether or not the flow is turbulent as the calculation for skin friction is different for turbulent flow. 

The induced drag is the drag resulting from lift. It is caused by the 3D effect of vorticity. As the high pressure air underneath the wing flows over to the top of the wing, a vortex forms behind the wing at the trailing edge. This vortex reduces the effective angle of attack and leads to another component of drag. 
Similar to CL, CD can be broken up into CDmin and CDi. Since CDi is a function of CL, it makes sense that CDmin is a constant value. This is illustrated in Figure 3 below.
[image: ]
Figure 3. Drag Coefficient vs. Angle of Attack

Pitching Moment Coefficient
The pitching moment M on an airfoil is caused by the net aerodynamic force acting on it. It is calculated with respect to the aerodynamic center of the airfoil. Equation 7 shows how to find the pitching moment Mc at the aerodynamic center of the airfoil,
                                                     
                                                                                        (7)
where Mc, D and L are the pitching moment, drag and lift measured by the sensor, and x is the distance between the aerodynamic center of the airfoil and the measurement point.

More lift is needed to overcome the pitching moment. Since the lift acting at the center of pressure will be hard to calculate when center of pressure changes due to the change of angle of attack, the pitching moment coefficient Cm becomes significant here. Equation 8 shows that in two-dimensional, the pitching moment coefficient Cm is calculated dividing the pitching moment by the  dynamic pressure q and the square of the chord of the airfoil c.
                                                                      	                                           (8)

Procedure
To study the RAE 2822 airfoil, a 2D Reynolds-Averaged Navier Stokes code based on flo53 was used and the results were visualized with FieldView. First, a rae.inp file was inputted to flomg.exe, the executable CFD code. This is done in the command prompt, as flomg does not have a GUI. Rae.inp feeds details about the airfoil geometry and flow conditions to flomg.exe. The rae.inp file was edited for each of the 21 cases, changing the mach number and angle of attack. An example is shown in Figure 4. The output file contains the values for Cl, Cd, and Cm, shown in Figure 5. These were collected in Excel for later processing. After each run of flomg.exe, a new file is created called fort.10, which contains the grid and flow field information that FieldView will eventually use. However, FieldView cannot use that file type directly, so the program xyzq.exe was run to convert fort.10 into PLOT3D grid and solution files, which show up as .xyz and .q files, respectively. This process was repeated for each case, and the PLOT3D files were saved for later use.
[image: ]
Figure 4. Example of where the rae.inp file needs to be edited
[image: ]
Figure 5. Example of the important values in the output file
Next, FieldView was used to visualize and analyze the data. In FieldView, the data was inputted by following these instructions:
Go to File>Data Input>PLOT3D, then select the .xyz and .q files for the case being done in “Read XYZ Data…” and “Read Q Data…”, then close the window. Select the button in the top left with the “XYZ” on it, and then select a viewing direction of +Z to view only the X-Y plane of the airfoil. Select Visualization Panels>Computational Surface. This window allows for the creation of all the figures used in this report.

Mach number, Cp, and density are examined in this report. To create a contour of mach number, select Velocity Vectors for the Vector function and Mach Number for the Scalar function, then click “Create”. Under “Coloring”, select “Scalar”, and under “Display Type”, select “Constant”. If contours are desired, select “Geometric” under “Contours”. Turn on a legend in the “Legend” tab, and close the window. Zoom in the main window by dragging with the right mouse button. View the desired features and save the image if desired by selecting File>Save Image>Graphics>PNG. For density, perform the same steps as above, except select “Density” for the Scalar Function.

To get a Cp plot, select “Cp” as the Scalar Function. Select “Surface Plot” at the top of the window and a new one opens. Ensure that the Slicing Axis is J and the Slice is set to 1. The horizontal axis should be X. Go to the Annotation tab, and make the horizontal axis -0.2 to 2, and the vertical axis should be flipped, going from about +1 to -2.

Results and Discussion: 
A. Flow Field Analysis
i) Shock Wave Analysis
As mentioned in the introduction, the properties of flow will experience large changes across shock wave. Use the low transonic condition (Mach number = 0.8 and Angle of attack = 10 degrees) as example.  

Figure 6 shows there is a strong shock appears on the middle of airfoil where the plot turns from yellow to green. In addition, Figure 6 to Figure 10 shows there is large decrease in Mach number and velocity across shock wave, while the static pressure, temperature and density dramatic increase after shock wave. Figure 6.FieldView Mach number for M=0.8, Angle of Attack =10 degrees

[image: ]
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Figure 7.FieldView Velocity for M=0.8, Angle of Attack =10 degrees



[image: ]Figures 8, 9, and 10 show that before the shock wave, the static pressure, temperature and density is much lower than the freestream value. While across the shock wave, these properties return to the original freestream properties. The several different color section compared to freestream color section close to trailing edge is caused by turbulence.
Figure 8.FieldView Pressure for M=0.8, Angle of Attack = 10 degrees

[image: ]Figure 9.FieldView Temperature for M=0.8, Angle of Attack = 10 degrees

The figures below compare shock wave position along the airfoil with respect to different Mach numbers in low transonic conditions (Mach number = 0.8 and 0.9, AoA=0), high transonic conditions (Mach number = 1.1 and 1.2, AoA=0) and supersonic conditions (Mach number=1.4 and 1.7, AoA=0), while maintaining a constant angle of attack. 

As shown in Figure 11 and Figure 12, shock wave will move toward trailing edge as the Mach number increase in low transonic condition. When a shock wave move toward trailing edge, the pressure drag will decrease due to the separation region of the flow along airfoil becoming smaller. 
[image: ]Figure 10.FieldView Density for M=0.8, Angle of Attack = 10 degrees

[image: ]Figure 11.FieldView Coefficient of Pressure for M=0.8, Angle of Attack = 0 degrees

[image: ]
Figure 12.FieldView Coefficient of Pressure for M=0.9, Angle of Attack = 0 degrees
In high transonic conditions, the bow shock will be introduced at a location in front of the leading edge. In addition, there is a trailing edge shock wave at trailing edge. In Figure 13 and Figure 14, when the Mach number increase from 1.1 to 1.2, the bow shock wave become stronger and clearer to see. [image: ][image: ]Figure 13. FieldView Coefficient of Pressure for M=1.1, Angle of Attack = 0 degrees

Figure 14.FieldView Coefficient of Pressure for M=1.2, Angle of Attack = 0 degrees
In the supersonic condition, as the Mach number increases, the bow shock will curve toward airfoil and the trailing edge shock wave will bend toward the chordline of airfoil which can be observed from Figure 15 and Figure 16.

[image: ]
Figure 15.FieldView Coefficient of Pressure for M=1.4, Angle of Attack = 0 degrees
[image: ]
Figure 16.FieldView Coefficient of Pressure for M=1.7, Angle of Attack = 0 degrees

The figures below compare the shock wave position along the airfoil with respect to different angle of attack in a low transonic condition (Mach number = 0.9, AoA = -6, 6), high transonic condition (Mach number = 1.2, AoA = -6, 6), and supersonic condition (Mach number = 1.7, AoA = -6, 6). 

For the low transonic condition (Mach number = 0.9), we can see when the angle of attack is negative , Figure  17, the shock wave on the lower surface of airfoil will be much stronger than the shock located on the upper surface. In contrast, when angle of attack is positive, Figure 18, the shock wave on the upper surface will become much stronger than the one on the lower surface. 
[image: ]
Figure 17.FieldView Coefficient of Pressure for M=0.9, Angle of Attack = -6 degrees
[image: ]
Figure 18. FieldView Coefficient of Pressure for M=0.9, Angle of Attack = -6 degrees

In a high transonic condition (Mach number =1.2), when angle of attack is negative , Figure 19,  the center of the bow shock will slightly move upward and the flow properties will experience more dramatic change on the lower surface. In contrast, when the angle of attack is positive, Figure 20, the bow shock’s center will move downward, and the flow properties will experience more dramatic changes on the upper surface of the airfoil. 

For the trailing edge shock wave, in negative angle of attack, the lower surface will have a stronger shock wave when compared to upper surface. For a positive angle of attack, the trailing edge shock wave will be stronger for the upper surface of airfoil compared to the lower surface.
[image: ]Figure 19.FieldView Coefficient of Pressure for M=1.2, Angle of Attack = -6 degrees


[image: ]
Figure 20.FieldView Coefficient of Pressure for M=1.2, Angle of Attack = 6 degrees

For Figure 21 and Figure 22, in the supersonic condition (Mach number = 1.7), the bow shock in front of the airfoil will have similar movement to the high transonic condition. Negative angles of attack will cause the bow shock to move slightly upward, while positive angles of attack will cause it to move downward.

The negative angle of attack is shown to have a stronger trailing edge shock wave and more dramatic change in flow properties after bow shock on the lower surface of the airfoil. The positive angle of attack have a stronger trailing edge shock wave and more dramatic change in flow properties after the bow shock will occur on the upper surface of airfoil.

[image: ]
Figure 21.FieldView Coefficient of Pressure for M=1.7, Angle of Attack = -6 degrees


[image: ]
Figure 22.FieldView Coefficient of Pressure for M=1.7, Angle of Attack = 6 degrees

[bookmark: _7t6mmjoju83m]ii) Pressure Analysis
[bookmark: _gjdgxs]
The pressure distribution over the different Mach numbers used in this study were similar for certain angles of attack, but at the same time, very different for others. 

[image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M2a2_CPWING.PNG][image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M2A2_CP.PNG]
Figure 23. Distribution of the Coefficient of Pressure Along the Airfoil for M=.2 and AoA= 2

[image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M2A10_CPWING.PNG][image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M2A10_CP.PNG]
Figure 24. Distribution of the Coefficient of Pressure Along the Airfoil for M = .2 and AoA = 10
[image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M2A10_CPWING (Tip Detach).png]
Figure 25.Traces of the Coefficient of Pressure at the tip for M = .2 and AoA = 10
Figures 23 and 24 show the pressure distribution for a Mach number of 0.20, with angles of attack of 2 and 10 degrees. Both figures show a stagnation point where  but due to their different angles of attack, the location and size are different. Figure #1 shows a region of negative Cp on the upper surface of the airfoil. Figure 24 shows a nearly instantaneous flow separation at the tip due to the greatly increased angle of attack. The Cp along the airfoil’s upper surface is too close to the ambient to allow for the generation of lift, and the flow does not reattach as sometimes seen in cases of high angle of attack. 
Figure 25 takes a closer look at the separation point for  and angle of attack is 10 degrees. Near the tip of the airfoil, there is a shed vortex created by the large negative pressure gradient. This vortex creates a vacuum that induces reverse flow.

[image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M5A4_CPWING.PNG][image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M5A4_CP.PNG]
Figure 26. Distribution of the Coefficient of Pressure Along the Airfoil for M = .5 and AoA = 4
[image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M5A10_CPWING.PNG][image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M5A10_CP.PNG]
Figure 27. Distribution of the Coefficient of Pressure Along the Airfoil for M = .5 and AoA = 10
[image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M5A10(Separation).jpg]
Figure 28. Separation and Reverse Flow of M=.50 and AoA = 10
Figures 26 and 27 show the distribution of the coefficient of pressure for Mach 0.50 and angles of attack of 4 and 10 degrees. Figure 26 shows a standard Cp distribution with uninterrupted, attached flow. By increasing the angle of attack to 10 degrees, a separation point appears at the leading edge’s upper surface. As shown in Figure 28, the flow almost immediately detaches from the airfoil. Unlike Figure 25 where, the flow does reattach on the right-hand side of Figure #6. This can be seen in Figure 25, as represented where the coefficient of pressure starts to increase in magnitude.
[image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M8A2(CPWING).png][image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M8A2(CP).png]
Figure 29. Distribution of the Coefficient of Pressure for M = .8 and AoA = 2
[image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M8A2(CPWING Reverse Flow).png]
Figure 30.  Flow Detachment for M = .8 and AoA = 2

[image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M8A10(CPWING).jpg][image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M8A10(CP).png]
Figure 31. Distribution of the Coefficient of Pressure at M = .8 and AoA of 10
[image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M8A10(Separation).jpg]
Figure 32. Detachment and Reattachment of Flow at M = .8 and AoA = 10

Figures 29 and 31 show the distribution of Cp over the airfoil at Mach 0.8 and angles of attack of 2 and 10, respectively. As  is the initial boundary of transonic flight, both transonic and subsonic effects are present.
As shown in Figure 29, a shockwave is emanating from the upper surface, but due to an  degrees, it is not present on the lower surface. The flow detaches from the airfoil at the shock due to the adverse pressure gradient. This is seen in Figure 30 by the presence of reverse flow. When the angle of attack is increased to 10 degrees, Figure 31, a much larger shock wave is formed.  As the pressure gradient is much larger than that found at an angle of attack of 2 degrees, the flow detaches much sooner and a vortex is formed. Due to this vortex, the flow reattaches to the airfoil near the trailing edge as seen in Figure 32. 

iii) Density Analysis
The densities examined in the flow fields for each corresponding Mach number and angle of attack show several variations based largely upon subsonic and transonic effects. For flows with a Mach number of 0.2, the flow is subsonic, low speed and essentially incompressible.  Figure 33 shows the flow field density for Mach number 0.2 and an Angle of Attack of 0 degrees.
[image: ]
Figure 33. Flow Field Density (M=0.2 and AOA=0 degrees)
As expected, there is a stagnation point at the leading edge of the airfoil. The density spikes at the stagnation point as a result of high pressure caused by flow speed decelerating to zero. The density then levels off to an approximately constant value across the rest of the airfoil. It is important to note that the density scale is only between 0.982-1.020, which indicates that the density is relatively unchanged across the airfoil for low subsonic flow. However, increasing the angle of attack will cause density to vary much more across the airfoil.
For flows with a Mach number of 0.5, the flow is also subsonic, but the compressibility effects start to become important. Figure 34 shows the flow field density for Mach number of 0.5 and an Angle of Attack of 6 degrees.
[image: ]
Figure 34. Flow Field Density (M=0.5 and AOA=6 degrees)

The stagnation point is located slightly below the leading edge due to the Angle of Attack being higher than 0 degrees. The density is once again greatest at the stagnation point due to the high pressure caused by the flow being brought to rest. The density then momentarily drops off across the top of the leading edge before leveling back to a constant density across the rest of the airfoil. It is evident that compressible effects have become important for M=0.5, as the density scale varies much more (0.341-1.129) in comparison to the scale for M=0.2 at the same angle of attack (0.874-1.020).
For flows with a Mach number of 0.8, the flow becomes transonic and a local supersonic region and shockwave are usually present. Figure 35 shows the flow field density for Mach number 0.8 and an Angle of Attack of 10 degrees.
[image: ]
Figure 35. Flow Field Density (M=0.8 and AOA=10 degrees)
A stagnation point is present slightly below the leading edge due to the high Angle of Attack used. The density is highest at the stagnation point due to high pressure caused by the flow decelerating to zero. The flow becomes supersonic across the leading edge of the airfoil and is followed by a shock wave present at a distance slightly less than half of the chord length. The density is lowest across the region where the flow becomes supersonic. After the shock wave, the flow returns to subsonic and the density increases across the rest of the airfoil. The density also decreases near the trailing edge which indicates that boundary layer has begun to separate.

iv) Subsonic and Low Transonic Mach Number Analysis
At the lowest Mach number tested, M = 0.2, the airfoil behaved as would be expected of a thin airfoil in laminar flow. The outer flow stays attached to the airfoil for all cases. Minor flow reversal is seen in the extreme case of α = 10, and that is covered in the section on separation bubbles. The Mach number contours for free stream Mach number of 0.2 and angle of attacks from 0 to 10 are shown below in Figure 36. The colors indicate Mach number, but they have relationships to pressure. The slowest regions here will also be the regions of highest pressure. Likewise, the fastest regions will be areas of lower pressure. This is not always true though.
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	M = 0.2, α = 0
	M = 0.2, α = 2
	M = 0.2, α = 4
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	M = 0.2, α = 6
	M = 0.2, α = 8
	M = 0.2, α = 10



Figure 36. Relative Mach numbers around airfoils at increasing α for free stream M  = 0.2
Figures 37 and 38 below show the most extreme results at the 0.2 Mach number, both at α = 10. Figure 37 shows the slower region of flow in the wake of the airfoil, which is the first sign of flow separation. If the flow were faster, or if the airfoil were at a higher angle of attack, the flow would separate at some point along the top of the airfoil. Figure 38 shows the accelerated flow over the leading edge of the airfoil. Since it has a positive angle of attack, the stagnation point is on the underside of the airfoil, and the accelerated flow is on top, reaching a Mach number of 0.531, significantly higher than the freestream Mach number.

[image: ]
Figure 37.Wake for M = 0.2, α = 10
[image: ]
Figure 38. Leading edge for M = 0.2, α = 10

When the freestream Mach number is increased to 0.5, more interesting things occur. Figure 39 below shows the Mach number contours for M = 0.5 and α from 0 to 10 degrees. It represents the beginning of the transonic range, as Mach numbers reach M = 1.77 in certain parts of the airfoil. At angles of attack between -2 and 2, the flow remains subsonic everywhere and the flow stays attached; the airfoil behaves as expected for subsonic flow. Beginning at α = 4, the flow exceeds M = 1 at the leading edge. For all angles, the supersonic region is small and resides only at the leading edge, although its effects spread out as the angle increases. For α = 4 and α = 6, the flow reattaches quickly and seems to stay attached, however for angles 8 and 10 degrees, the flow doesn’t reattach well and its effects would cause loss of lift.
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	M = 0.5, α = 0
	M = 0.5, α = 2
	M = 0.5, α = 4
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	M = 0.5, α = 6
	M = 0.5, α = 8
	M = 0.5, α = 10



Figure 39.Relative Mach numbers around airfoils at increasing α for free stream M  = 0.5
Figure 40 below shows the Mach number contour for α = 10 degrees and M = 0.5. The flow attempts to reattach at the front of the airfoil, but it isn’t totally effective, as seen by the small bump in the slow region of flow just to the right of the high speed part. This extends down the airfoil in the form of a thicker boundary layer, and early separation once an adverse pressure gradient shows up, which is the curve of the airfoil in this case. Supercritical airfoils were developed for commercial planes in the 60’s, which prevent this separation from happening. They have a flatter top and a more cambered bottom, removing the downward turn on the top of a normal airfoil (including this  RAE 2822). That turn creates an adverse pressure gradient and causes flow separation when the flow is already prone to it, like it is here. Supercritical wings allow planes to fly at high transonic speeds without losing much lift to the effects of shocks on top of the wings (Harris).
[image: ]
Figure 40. Mach number contour for α=10 and free stream M  = 0.5

v) Streamlines and Separation Bubbles
The velocity streamlines were plotted around the airfoil in the following figures.  The analysis of streamlines and separation bubbles were examined at various Mach numbers and angle of attack.  The x-velocity component was plotted on each figure.
[image: m8_a10.png]
Figure 41.Flow Field Velocity (M=0.8 and AOA= 10 degrees)

Figure 41 above shows a shock induced separation along the upper surface of the airfoil.  In the region of the large bubble the flow is reversed shown in the color blue.  This is called a laminar bubble.  A turbulent reattachment point is located at the trailing edge of the bubble where the flow reattaches to the airfoil. 
[image: m8_a-2.png]
Figure 42. Flow Field Velocity (M=0.8 and AOA= -2 degrees)

Figure 42 above shows the airfoil at the same freestream Mach number, but -2 degrees AoA.  An adverse pressure gradient is shown to develop on the lower surface of the airfoil.  This is due to shock induced separation on the lower surface. This shows similar results to Figure 41, but contains a smaller separation bubble.  As the angle of attack is more positive, or negative the size/strength of the bubble increases. 

Figure 43 below shows an example at a lower free stream Mach number.  There is a small separation bubble located along the upper and lower surface near the leading edge.  The flow reverses inside both of the separation bubbles.  The flow reattaches after the transition from laminar to turbulent flow.  The magnitude of the separation bubble is also a function of the free stream Mach number.  Higher free stream flow causes larger bubble separation as seen in Figure 41. 
[image: m2_a10.png]
Figure 43.Flow Field Velocity (M=0.2 and AOA= 10 degrees)



B. Aerodynamic Characteristics
For each Mach number, we plotted a graph of Cd vs Cl for all the angles of attack (alpha) and two other graphs of Cl vs alpha and Cm vs alpha, shown below in Figures.

Lift Coefficient vs Mach number
 As seen from the CD v CL plots, from Mach 0.2 to 0.5, as M increases, the CL values increase; with CL max increasing from 1.1873 to 1.2664. 
However, as the Mach number increased to 0.8 the max CL value drops to 0.9196. While the change in CL was not very drastic, the important take away was how the graph started to turn around after passing an angle of attack of .5 degrees for Mach 0.8. With Mach 0.2 and 0.4 changing at an angle of attack of 4.5 degrees. This may lead to stall as CL begins to drop after CL max is reached.
[image: ]
Figure 44. Cd vs Cl for each Mach number


Drag Coefficient vs Mach number 
The value of CD max rises as the Mach number increases. CD for Mach 0.2 and 0.5 peaked at 0.0715 and 0.0852. At Mach 0.8 CD jumped to 0.139. This data alone shows that the compressibility effects due to the shock dramatically increase the drag on the airfoil.

Airfoil Efficiency (Cl/Cd, same as the inverse of Cd/Cl) 
From the CD v CL plot in figure 44, we can say that the smaller the slope is, the more efficient the aircraft is; the steeper the slope is, the less efficient the aircraft is.  For M = 0.2 and M = 0.5, the slope is continuously flat until angle of attack reaches 4 degrees; then the slope becomes steep and more steep. Therefore, for M = 0.2 and M = 0.5, the aircraft is very efficient until alpha reaches 4, after that it becomes less and less efficient. However, for M = 0.8, the aircraft becomes less efficient as alpha increases when angle of attack is positive. After reaching the CL peak at an angle of attack of 6 degrees, the CL begins to decrease but the CD still increases; and therefore the efficiency of the aircraft becomes negative at this time. In conclusion, for really high Mach numbers, such as M=0.8, the aircraft is very hard to keep efficient; but it’s much easier to keep high efficiency at lower Mach numbers. 
[image: ]
Figure 45. Cl vs α for each Mach number

Lift Coefficient vs angle of attack (alpha)
When lift coefficient is plotted against angle of attack for the three Mach numbers, the effects of compressibility are evident again. The CL increases as angle of attack increases. The lift curve slope of M=0.5 is similar but always higher than that of M = 0.2, however it changes significantly by M = 0.8. For the lower Mach numbers, the maximum CL is achieved at the highest angle of attack, and we haven’t reached the point of wing stall. However, at M=0.8, the max CL is reached at α = 6 degrees, and lift is lost at higher angles of attack. Before angle of attack reaches 6 degrees, the CL at a higher Mach number is always larger than the CL at lower Mach numbers for the same angles of attack. However, at α = 6 degrees, the CL of M = 0.8 is comparable to CL for the same angles of attack at lower Mach numbers. That means the wing will perform similarly at angles of attack up to 6 degrees across this range of Mach numbers. Nearing transonic velocities, such as the M = 0.8 case, stall occurs earlier due to shocks on the wing, triggering flow separation. This is discussed further in the section looking at Mach number.

Pitching Moment Coefficient vs angle of attack (alpha)
Lastly, Cm vs. angle of attack:

From the plot, we can see that before alpha reaches 5 degrees, the magnitude of Cm increases as alpha increases. For M = 0.2, the magnitude of  Cm starts to decrease after alpha reaches 6 degrees; for higher Mach numbers, the magnitude of  Cm starts to decrease after alpha reaches 4 degrees. Also the turn of the Cm slope becomes more drastic for higher Mach number. The magnitude of Cm for M = 0.8 becomes tremendously higher than that of the lower Mach numbers. However, for M = 0.5, the magnitude of Cm starts to increase again after alpha reaches 8 degrees. When pitching moment increases, the aircraft needs more lift to overcome the moment. Therefore, before alpha reaches 4 degrees, the lift needed to overcome the pitching moment is similar for M = 0.2 and M = 0.5; but after alpha reaches 4 degrees, the aircraft will [image: ]
Figure 46. Cm vs α for each Mach number

need less lift to overcome the pitching moment for M = 0.5. For M = 0.8, the aircraft will always need a much larger lift to overcome the pitching moment for the lower Mach numbers, until alpha reaches 10 (where the difference of Cm becomes much smaller).

Conclusion
The RAE 2822 airfoil was tested at lower subsonic speeds with less compressibility effects, and higher transonic speeds similar to that of commercial transport aircraft.  Angle of attack was varied from -2 to 10for Mach 0.2, 0.5, and 0.8.  

The shock waves can be observed for low transonic, high transonic and the supersonic flow. The properties change rapidly across the shock wave. In addition the location and the strength of shock wave will vary with change of Mach number and angle of attack.

Higher coefficients of lift were recorded for higher angle of attacks with lower Mach numbers.  Higher free stream Mach number led to higher lift for smaller angles of attack, but reached  earlier.  Coefficient of drag was found to increase suddenly after certain angles of attack.  For Mach 0.8 the coefficient of drag rose dramatically immediately after an angle of attack around 0to 1.  Mach numbers of 0.2 and 0.5 didn’t see a dramatic increase in drag until 4to 5 angle of attack.  It was found that the RAE 2822 airfoil was more efficient at lower Mach number conditions.  At transonic flow the compressibility effects due to the shock dramatically increase the drag on the airfoil.

The analysis of separation bubbles was compared from 0.2 Mach to 0.8 Mach.  The experiment showed as Mach number increased, the size/strength of the separation bubble increased.  This is due to shock waves increasing in strength and moving towards the trailing edge of the airfoil.  Shock induced separation was observed at higher transonic flow.  After the shock waves the density and pressure decrease significantly while temperature rises. 

Testing these angles of attack at supersonic flow would allow for more analysis of compressibility effects.  Also, observing the RAE 2822 airfoil at -90to 90 angle of attack would allow for full digestion of the overall efficiency of the airfoil.  This method would also be beneficial for stunt/acrobatic pilots seeking to fly at extreme angles of attack at various mach numbers. 
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Figure 1. RAE 2822 Airfoil (UIUC Applied Aerodynamics Group)
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Figure 2. Lift coefficient vs. Angle of Attack 
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Figure 3. Drag coefficient vs. Angle of Attack 
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Figure 4. Example of where the rae.inp file needs to be edited
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Figure 5. Example of the important values in the output file
	[image: ]Figure 6. FieldView Mach number for 
M=0.8, AOA=10 degrees
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Figure 7. FieldView Velocity for M=0.8, AOA=10 degrees
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Figure 8, FieldView Pressure for M=0.8, Angle of Attack = 10 degrees
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Figure 9, FieldView Temperature for M=0.8, Angle of Attack = 10 degrees
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Figure 10, FieldView Density for M=0.8, Angle of Attack = 10 degrees
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Figure 11, FieldView Coefficient of Pressure for M=0.8, Angle of Attack = 0 degrees
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Figure 12, FieldView Coefficient of Pressure for M=0.9, Angle of Attack = 0 degrees
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Figure 13, FieldView Coefficient of Pressure for M=1.1, Angle of Attack = 0 degrees
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Figure 14, FieldView Coefficient of Pressure for M=1.2, Angle of Attack = 0 degrees
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Figure 15, FieldView Coefficient of Pressure for M=1.4, Angle of Attack = 0 degrees
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Figure 16, FieldView Coefficient of Pressure for M=1.7, Angle of Attack = 0 degrees
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Figure 17, FieldView Coefficient of Pressure for M=0.9, Angle of Attack = -6 degrees
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Figure 18 , FieldView Coefficient of Pressure for M=0.9, Angle of Attack = 6 degrees
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Figure 19, FieldView Coefficient of Pressure for M=1.2, Angle of Attack = -6 degrees
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Figure 20, FieldView Coefficient of Pressure for M=1.2, Angle of Attack = 6 degrees
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Figure 21, FieldView Coefficient of Pressure for M=1.7, Angle of Attack = -6 degrees
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Figure 22, FieldView Coefficient of Pressure for M=1.7, Angle of Attack = 6 degrees
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Figure 23-(1). Distribution of the Coefficient of Pressure Along the Airfoil for M=.2 and AoA= 2
	[image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M2A2_CP.PNG]
Figure 23-(2). Distribution of the Coefficient of Pressure Along the Airfoil for M=.2 and AoA= 2
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Figure 24-(1). Distribution of the Coefficient of Pressure Along the Airfoil for M = .2 and AoA = 10
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Figure 24-(2). Distribution of the Coefficient of Pressure Along the Airfoil for M = .2 and AoA = 10
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Figure 25. Traces of the Coefficient of Pressure at the tip for M = .2 and AoA = 10
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Figure 26-(1). Distribution of the Coefficient of Pressure Along the Airfoil for M = .5 and AoA = 4
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Figure 26-(2). Distribution of the Coefficient of Pressure Along the Airfoil for M = .5 and AoA = 4
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Figure 27-(1). Distribution of the Coefficient of Pressure Along the Airfoil for M = .5 and AoA = 10
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Figure 27-(2). Distribution of the Coefficient of Pressure Along the Airfoil for M = .5 and AoA = 10
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Figure 28. Separation and Reverse Flow of M=.50 and AoA = 10
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Figure 29-(1). Distribution of the Coefficient of Pressure for M = .8 and AoA = 2
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Figure 29-(2). Distribution of the Coefficient of Pressure for M = .8 and AoA = 2
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Figure 30. Flow Detachment for M = .8 and AoA = 2
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Figure 31-(1). Distribution of the Coefficient of Pressure at M = .8 and AoA of 10



	[image: C:\Users\Oron Rosenberg\AppData\Local\Microsoft\Windows\INetCache\Content.Word\M8A10(CP).png]
Figure 31-(2). Distribution of the Coefficient of Pressure at M = .8 and AoA of 10
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Figure 32. Detachment and Reattachment of Flow at M = .8 and AoA = 10
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Figure 33:Flow Field Density (M=0.2 and AOA=0 degrees)
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Figure 34:Flow Field Density (M=0.5 and AOA=6 degrees)
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Figure 35:Flow Field Density (M=0.8 and AOA=10 degrees)
	[image: ]Figure 36-(1): Relative Mach numbers around airfoils at increasing α for free stream M  = 0.2 (α=0)
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Figure 36-(2): Relative Mach numbers around airfoils at increasing α for free stream M  = 0.2 (α=2)
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Figure 36-(3): Relative Mach numbers around airfoils at increasing α for free stream M  = 0.2 (α=4)
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Figure 36-(4): Relative Mach numbers around airfoils at increasing α for free stream M  = 0.2 (α=6)
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Figure 36-(5): Relative Mach numbers around airfoils at increasing α for free stream M  = 0.2 (α=8)
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Figure 36-(6): Relative Mach numbers around airfoils at increasing α for free stream M  = 0.2 (α=10)
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Figure 37: Wake for M = 0.2, α = 10
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Figure 38: Leading edge for M = 0.2, α = 10
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Figure 39-(1): Relative Mach numbers around airfoils at increasing α for free stream M  = 0.5 (α=0)
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Figure 39-(2): Relative Mach numbers around airfoils at increasing α for free stream M  = 0.5 (α=2)
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Figure 39-(3): Relative Mach numbers around airfoils at increasing α for free stream M  = 0.5 (α=4)
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Figure 39-(4): Relative Mach numbers around airfoils at increasing α for free stream M  = 0.5 (α=6)
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Figure 39-(5): Relative Mach numbers around airfoils at increasing α for free stream M  = 0.5 (α=8)
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Figure 39-(6): Relative Mach numbers around airfoils at increasing α for free stream M  = 0.5 (α=10)
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Figure 40: Mach number contour for  α=10 and free stream M  = 0.5
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Figure 41:Flow Field Velocity (M=0.8 and AOA= 10 degrees)
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Figure 42:Flow Field Velocity (M=0.8 and AOA= -2 degrees)
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Figure 43:Flow Field Velocity (M=0.2 and AOA= 10 degrees)
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Figure 44: Cd vs Cl for each mach number
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Figure 45: Cl vs α for each mach number
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Figure 46: Cm vs α for each mach number
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